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Broedel warns: Better safe than sorry!

Milt Broedel will be our presenter on Tuesday,
October 2, 2007 at 6pm at the Whitesboro
Senior High School Cafeteria. His topic is

Computer Security and he’ll update
us in a number of important areas.

Milt will use a well-organized PowerPoint

slide show to cover topics that will include:

* W ireless security — more and more of

us are using wireless connections, both

in the home or at work . . . or at places

like Panera’s (wireless café).

* Firewall — routers and networks require

firewalls to prevent unwanted intrusion,

especially with broadband connections continually

“open”.

* Vista updating — for those who have moved, or are

considering moving to the Vista operating system, new

actions are necessary for your protection.

* Adware, Spyware, and Spam — these destructive

software invaders continue to plague our computers.

What’s the latest and best software solutions to these

trouble-makers?

Milt Broedel is a most knowledgeable computer buff. He runs his
own computer business, helping users to maintain or repair their
equipment. He teaches courses in the use of software (Word, etc.)
for area BOCES. Bob Schaffer knows Milt as they have classrooms
just two doors away from each other at the BOCES Utica site. Milt
has been a presenter at previous MVPCUG meetings and has
been very well received. �

Fasoldt schedules
new workshops 

Al’s Technofile Workshops are
set to begin in October,
addressing issues many past
class participants have
suggested: 
housekeeping tips for your PC
and Mac, 
bargain hunting for utility
software, 
digital photography class,
internet safety, 
and even a mighty leap into        

    cracking the mysteries of            
    MySpace.

   All of the seminars are low-cost,
with most costing only $30 for a
2.5 hour session.

   For further information email Al
at nfasoldt@twcny.rr.com and ask
to be put on the mailing list. If
there is sufficient interest, Al will
hold workshops in the Utica area. 

mailto:nfasoldt@twcny.rr.com
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The MVPCUG EXPLORER is published monthly from September

through June by the Mohawk Valley Personal Computer User Group,

Inc.(MVPCUG), PO Box 586, Marcy NY 13403-0586.

Opinions expressed herein are the writers and are not reflective of

the MVPCUG, nor are they considered substantiated by inclusion in

this newsletter. All articles are copyrighted by their respective authors

but may be reprinted by other User Groups provided credit is given to

the author and this publication.

The. MVPCUG was founded in 1981 by individuals interested in

IBM compatible computers. This non-profit organization consists of

volunteers whose expertise range from novice to professional.

Regular meetings are held on the first Tuesday of the month at

6pm, usually at the Whitesboro High School, Route 291, Marcy NY.

A typical agenda consists of discussion of business affairs and a

demonstration of computer related products.  Meetings are open to the

public.

Initial membership fee for an individual is $25. Annual renewal
dues are $20.
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Editorial notes . . .

In December we will be voting
for our Board of Directors.
Nominations will be taken at
the meetings in October and
November for officers and one
director. The proposed slate will be published in
the November issue of Explorer.

More on how to get along with WindowsXP—
By default XP has an annoying dialog box that

pops up whenever a program crashes. It wants
you to send a report to Microsoft. [These crashes
happen more often than when I used Windows98].
To turn off error reporting right-click My Computer,
then choose Properties and the Advanced tab.
Click on the Error Reporting button at the bottom
of the dialog box. You then can enable or disable
error reporting.

Meeting Agenda

5:30. . . . . . . . . . . . . . . Meet and Greet
6:00. . . . . . . . . . . . . Business Meeting
6:30. . . . . . . . . . . . . . . Program, Part 1
7:10. . . . . . . . . . . . . . . . . . . . . . . Break
7:20. . . . . . . . . . . . . . . Program, Part 2
8:00. . . . . . . . . . . . Drawing for Prizes
8:15. . . . . . . . . . . . . . . . . Adjournment

mailto:mvpcug@usadatanet.net
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The MVPCUG general meeting was held at the Whitesboro
HS cafeteria. President Jerry Finkelstein called the meeting to
order at 6:03 PM. There were 29 persons in attendance.

BUSINESS MEETING
President Jerry Finkelstein welcomed back the

members in attendance at the first meeting of our new year. 
Jerry called on Treasurer Bill Gorrell to present the
treasurer’s report. Bill reported that for the period May 31,
2007 to August 31, 2007 we received income totaling
$444.35. During the same period, our expenses totaled
$862.67, or $418.32 more than we received. Much of the
expense occurred from a $125 semiannual payment to St
John’s Church and an annual liability insurance premium of
$453. Bill indicated that the Whitesboro Central School
District requires this insurance from everyone who uses
school facilities. Jerry also indicated that he would submit
the insurance certificate to the school district and reserve
the cafeteria for the upcoming school year.

During general questions, a question arose regarding
the often discussed 50-50 raffle. President Jerry indicated
that the board had discussed the issue and had voted against
starting a 50-50 raffle. A number of members felt that all
legal requirements could be met since the club would
benefit from the sale of raffle tickets. Don Pianka moved
that the Board of Directors again discuss the institution of a
50-50 raffle. The motion passed.

PROGRAM
At 6:30 p.m. the Ask the Gurus program began.

Members asked questions regarding operating
systems, software, hardware and Internet safety
questions. With so few members in attendance at the
Utica Maennerchor, questions ran out rather quickly
and the program ended at 7:17 p.m.

DOOR PRIZES
[furnished with club funds]

Pen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Lisa Britt
15 8X DVD-R. . . . . . . . . . . . . . . . . . . . . . . . . Don Pianka
4 X 6 photo paper. . . . . . . . . . . . . . . . . . . . Helen Russell
CD Disks.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . Fred Cole
8 X 10 photo paper. . . . . . . . . . . . . . . . . . . . Dave Askew

[donated by Jerry Finkelstein]
Office supplies.. . . . . . . . . . . . . . . . . . . . . . . . Bill Gorrell

The meeting adjourned at 7:30 PM.

John Hunter, secretary �

Q. Can you explain how to back up Outlook Express
files and folders?

A. Sure. I assume you want to back up your Inbox,
Sent Items, Deleted Items, etc. There’s a relatively
easy—but inelegant—way to do it.

Outlook Express files end with dbx. So, you’ll get
Inbox.dbx, Folders.dbx, Offline.dbx, etc. The trick is
finding the dbx files.

A search in Windows Explorer probably won’t
work. The search function is awful. Besides,
Microsoft doesn’t like to expose system files. So we’ll
just have to track ‘em down!

To do that, open Outlook Express. Click Tools |
Options. Select the Maintenance tab. Click the Store
Folder . . . button. You’ll get a little Window that says
Store Location. A box within the windows contains
the path to the dbx files. This is the inelegant part.

Here’s my path: C:\Documents and
Settings\Kim\Local Settings\Application
Data\Identities\{86757014-3806-4091-ADBB-3CD3F
270ECE0}\Microsoft\Outlook Express. 

Use Windows Explorer to follow the path. The
dbx files are in the Outlook Express folder. As I said,
Microsoft really doesn’t want us messing with these
files. So they may be hidden. 

If you don’t see them, click Tools | Folder Options
in Windows Explorer. Click View. Under Advanced
Settings, select “Show hidden files and folders.”
Deselect “Hide extensions for known file types.” Also
deselect “Hide protected operating system files
(Recommended).” Click Apply | OK.

If you have a regular backup routine, just include
the dbx files. If you don’t, copy them to a flash drive,
second hard drive or CD. Do not copy them to the
hard drive on which they reside. Your biggest danger
is a hard drive failure. If that were to happen, it would
take the backup with it. 

Are you unable to check your spelling in Outlook
Express? It uses the spell checker in Microsoft Office
or Works. If you don’t have them, you have to
improvise. Outlook Express is a minimal program. If
you need something better, check Eudora. �

Copyright 2005 WestStar TalkRadio Network. Subscribe
to Kim Komando's free e-mail newsletters at:

www.komando.com

  Minutes of September 4, 2007
— John Hunter, Secretary  

Backing up Outlook Express files
— by Kim Komando

http://www.komando.com


  Word Processing Tips
— by Bob Schaffer  
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Word — 3 ways to insert an em dash
when AutoFormat falls down on the job

(2000/2002/2003)

The em dash, according to contemporary “author-
ities” is an omnipresent feature in writing. You’ll see
it in books, magazines, newspapers, and blogs. It’s
virtually taken the place of parentheses (which can
seem old-fashioned). It provides writers, for example, 
with an opportunity to interrupt their thought, to
present an “aside,” or to suggest urgency.

Here are three examples:
* This war in Iraq—just as was the case in

Vietnam—is dividing the country.
* I told her that she’d made a faux pas—not that it

was so terrible, Pete—and she fell apart.
* Please help us to raise the necessary funds—and

we do need them now—so the children will get at
least one square meal a day.
So get with it! Avoid those out-dated parentheses

and employ the elegant em dash.
É     É     É

Word’s default AutoFormat settings replaces two
hyphens (--) with a wide or em dash (—). But if you
want to insert one on the fly, or if you’ve disabled the
AutoFormat option, you can easily enter an em dash
using one of three methods:
1. Press [Ctrl][Alt][-] using the minus key on the

numeric keyboard.
2. Press [Alt] 0151. This comes in handy when you

don’t have a numeric keyboard, as is the case on
some laptops.

3. Select Insert | Symbol, and on the Special
Characters tab, select the Em Dash entry, click
Insert, and click Close. This is the perfect method
when you just can’t remember those shortcuts.

É     É     É
If you’d rather set up a new shortcut key combina-

tion, you can do so in the Symbol dialog box. Go to 
Insert | Symbol. �

Don’t throw away that old computer!
Bob Schaffer wants your old computer. It will be refur-

bished and given to an immigrant or refugee who is learning
English in Bob’s English for Speakers of Other Languages
program. Call 853-5984 to donate. Thanks!

WordPerfect —  Column Building
by Anne Steyer Phelps

Courtesy of Smart Computing Magazine

Click where you want the columns to begin. If
you’re designing a newsletter, for example, you’ll
probably want to click beneath the banner or title. 
1. On the Format menu,  choose Columns or click the

Columns button on the toolbar—the one with three
columns of blue lines—and choose Format. 

2. When the Columns dialog box appears, choose the
number of columns you’d like from the
corresponding box. 

3. Next, choose the style of column in the section
marked Type Of Column —this is where those four
options come in. Click on one to see a small
preview. 

4. Column width and spacing are a bit trickier. If
you’re unsure, you can leave
the settings in the
WordPerfect default and see
how you like it. If you prefer
to adjust them yourself, there
are a few things you should
know. 

5. WordPerfect displays a width box for each column
specified in the Number Of Columns field. You can
adjust the width of each column individually. To
change widths, click the Width box next to each
column and either type a new value or use the
box’s up or down arrows instead. 

6. You’ll notice the Fixed box next to Space is always
checked. In most cases, you’ll want uniform white
spaces to make your document easy to read. To
vary column separation, uncheck that box. 

7. If you’ve chosen Parallel or Parallel With Block
Protect as your column type, WordPerfect also
allows you to specify the number of blank lines
between rows. Click the up or down arrows in the
Extra Line Spacing In Parallel Columns box to
adjust this. 

8. Then click OK to create the columns. 
É     É     É

To discontinue columns, click where you want
them to end and:
1. Choose Columns from the Format menu. 
2. In the Columns dialog box, click Discontinue. 

É     É     É
To delete a column click the top-left corner of the col-
umn. In the Columns dialog box click Discontinue. �
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Q. I bought a couple Harry Potter audiobooks on CD.
I imported them into iTunes, but they don’t show up
in the Audiobooks section. They’re in the Music
section. Can I transfer them into the Audiobooks
section of iTunes and my iPod? I don’t want to rip the
CDs again—there were about 40!

A. iTunes handles audiobooks differently than music
files. It is possible to import books on CD into iTunes.

But unless you tweak some settings, they will be
treated like music files. For iTunes to  recognize an
audiobook, it must meet different requirements. It
must have a lower bitrate and a different file
extension.

I’ll get to your existing files in a moment. But
first, I'll explain how to create audiobooks from CDs.

First, change the import settings in iTunes. Click
Edit | Preferences and open the Advanced tab. Click
Importing. The files must be imported using the AAC
encoder.

Next, click the dropdown box labeled Setting.
Select Custom. For bitrate, select 64kbps or lower. If
the bitrate exceeds 64kbps, iTunes won’t recognize
the file as an audiobook. I also suggest that you select
“Optimize for voice.” Click OK.

Also, on the Importing tab, find On CD Insert. Set
that to Ask to Import CD. Click OK.

Insert a CD into your computer. When you insert
the CD, iTunes should display its tracks. Dismiss any
prompts. To make things easier, join the tracks
together before importing. That way, you won’t have
a million files for each book. Instead, you’ll have a file
[or two] per CD.

Select the tracks you’d like to join. Click
Advanced | Join CD Tracks. Click the Import CD
button.

Now, find the file in iTunes. Right-click the file
and select Get Info. You can fill in the information
about the file. For example, you can list J.K. Rowling
as the artist and Harry Potter and the Deathly Hallows
as the title.

You will also want to add the disc number. For
example, you should put 01/17 for the first disc. That
way it will sort correctly in iTunes and on your iPod.

Now, you need to find the file in Windows

Explorer. Right-click the track in iTunes and select
Show in Windows Explorer.

Once you find the track in Windows Explorer, you
must change the file extension. iTunes uses the M4A
extension for music files. Change that to M4B so it
will be treated as an audiobook.

Simply right-click the track in Windows Explorer
and select Rename. Change the extension. You’ll
receive a warning that the file might not open
correctly. Dismiss the warning.

If you can’t see the extensions, change the folder
options. Click Tools | Folder Options. [Click Organize
| Folder and Search Options, if you’re using Vista].
Open the View tab and deselect “Hide extensions for
known file types.” Click OK. You’ll see the file
extensions for all files.

Now, go back to iTunes and find the track in the
Music library. Right-click it and select Delete. Click
OK to delete the track from iTunes. iTunes will ask if
you want to remove the file from your computer.
Click No.

Return to Windows Explorer. Find the file and
drag it into the iTunes library. The file will be
imported into the Audiobooks section. It will function
like an audiobook purchased from iTunes or Audible.

So, let's get to your problem. You've imported the
files, but they're in the Music section. You're right;
there are a lot of CDs in the Harry Potter audiobooks.
I don’t blame you for not wanting to rip them again.
But you’ll probably need to change the files’ bitrate
before you can re-import them.

You can use BonkEnc to do this. This handy little
program converts music files to different formats. But
you can use it to change the bitrate of your files. 

In BonkEnc, click File | Add | Audio files. Select
your file(s) and click Open.

Next, you’ll need to set up the correct options.
Click Options | General settings. On the Encoder tab,
select FAAC MP4/AAC Encoder.

Click Configure encoder. On the Quality tab, enter
64kbps for the bitrate and click OK. Specify the
output folder and filename pattern for your converted
files. Click OK.

Finally, Click Encode | Start encoding. Once the
encoding is done, change the file extension. Then
import the files into iTunes using the steps above. �

Copyright 2005 WestStar TalkRadio Network. Subscribe
to Kim Komando's free e-mail newsletters at:

www.komando.com

Importing audiobooks into iTunes
— by Kim Komando

http://www.komando.com
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Books For Grownups

A
ARP has teamed up with Publishers Weekly
to identify books that mature readers will love
to read. Click on aarpmagazine.org/books and

see what PW recommends for adults who must read
books regularly. 
     On the date of my visit, Boomsday by Christopher
Buckley filled the lead. In the face of 77 million about-
to- retire baby-boomers, unwise tax cuts and soaring
federal deficits, Buckley proposes a solution worthy of
Jonathan Swift to keep social security solvent: a tax-
incentivized mass suicide of 65 and 70-year-old
boomers. For those who loved “A Modest Proposal,”
this satire may satisfy an incipient blood urge.
     Conveniently, the homepage provides a link to
Barnes and Noble should you wish to purchase your
own copy. Also provided is a Q & A interview with
the author, a social security chat room to allow you to
compare crazy solutions for keeping social security
solvent and a link to an AARP brochure titled “Nine
Ways to Keep Social Security Solvent.”

Click on another book link and get the current
monthly suggestions broken down by fiction and non-
fiction categories. The current fiction recommendation
is Circling My Mother by Mary Gordon. Another
book with an interesting title is Alone in the Kitchen
with an Eggplant: Confessions of Cooking for One
and Dining Alone edited by Jenni Ferrari-Adler. Read
on.

Keeping Kids Safe Online
The popularity of My Space, Facebook, YouTube

and other social online networking sites pose risks for
young people who face identity theft, sexual predators
and unwise postings that may come back to haunt
them. For example, prospective employers now
routinely check these sites to see what postings
individuals have made or postings that have been
made by others in their name.

To combat these threats, the US Postal Service
has teamed up with the National Center for Missing &
Exploited Children. The 2SMRT4U.com web site
provides kids with a “Type Smart. Post wisely,
message” of practical tips to stay out of trouble. Type
in the URL and the homepage provides tips for young
and unwary web browsers that help eliminate
predators and cyberbullies.

Typical advice urges young people to avoid
posting  names, addresses and cell phone numbers;
avoid posting social plans, activities or sexually
provocative photos. This seems simple, intuitive
advice, but young kids don’t think about these things
when they should. It helps to be careful and aware.

Election 2008
Even though adults approach the coming election

season with trepidation, many teachers believe that
elections produce teachable moments. Aaah!

The retiree’s best friend, C-Span, has provided
materials free for the asking for teachers in grades 6-
12 to use to boost interest and involvement in the
political process. C-SpanClassroom.org provides
discussion questions, downloadable video clips and
other materials to spark interest in the upcoming
election campaigns. In addition, C-Span also provides 
touring school bus visits that can be requested by
teachers. Click on Campaign2008Bus.org to request a
visit or check out the bus schedule.

Sorry, Wrong Number
Problem. You need to find phone numbers without

breaking your bank by calling 411. Solution.
Www.free411.com. The web site provides business
and personal telephone numbers free of charge. Just
type in the business name and city and state and up
comes the number. You can also find a personal
number just as easily. Just click on Find a Person and
type the name, city and state and up pops the number
if the number is not unlisted. So, lower your cell
phone bills and call 1-800-FREE-411 or use the URL.

This last tip came from Smart Computing
Magazine. I’m not so smart. I just read widely. 

Life and Death
You had a two-year subscription to a magazine

that suddenly died. And you got a subscription to
ESPN to complete the subscription even though you
hate sports. How can you avoid surprises like this
one? Easy. Just click on magazinedeathpool.com. The
anonymous scribe at this site predicts which
magazines will be the next to go. The current
candidate is Time-Warner’s Business 2.0. Another
recent casualty is reported to be Family Money.

For a more caustic comment on the magazine
industry, go to f- - - -dcompany.com. This site
broadens the view to include dot.com companies and
other possibly failing businesses. If you see your
company on this site, it’s permissible to panic.

Until next time . . . �

   Sites to Visit on the ‘Net
— by John Hunter    

http://WWW.aarpmagazine.org/books
http://www.2SMRT4U.com
http://Www.C-SpanClassroom.org
http://www.Campaign2008Bus.org
http://Www.free411.com.
http://www.magazinedeathpool.com.
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.. . . that you can print a list of Bookmarks from
Firefox? Open up Firefox’s Bookmark Manager -
Bookmarks | Organize Bookmarks. Hold down the
CTRL key, browse through the listings to find each of
the URL’s you need. Click on each needed one in
turn, still holding down the CTRL key. They don’t
need to be consecutive. When you have selected all
the ones you need, right click your mouse and select
Copy from the context menu. The list has now been
copied to your Clipboard. From there you can paste it
into Notepad, MS Word, etc. If you want to copy all
of your saved Bookmarks, just use File | Export and
create a HTML file to print out or copy to a disk.

.. . . that in the event your mouse stops working there
are keystrokes to use for just about every mouse
function? You probably know about copy [Ctrl+C],
paste [Ctrl+V], cut [Ctrl+X], and undo [Ctrl+ Z], but
there are many more. Some typists prefer using the
keystrokes instead of reaching for a mouse. Microsoft
has a full list of shortcut keystrokes at:
http://support.microsoft.com/kd/301583 

Other information:
* Some keyboard shortcuts may not work if
StickyKeys is turned on in Accessibility Options.

* Some of the Terminal Services client shortcuts that
are similar to the shortcuts in Remote Desktop
Sharing are not available when you use Remote
Assistance in Windows XP Home Edition.

* Some of the other Microsoft Knowledge Base
articles that have similar information as this article are:
[http://support.microsoft.com/kb/126449/] Keyboard
shortcuts for Windows and
[http://support.microsoft.com/kb/255090/] Keystroke
navigation in Windows 2000 Help

*Refer to Help for the most current information
regarding keyboard navigation and visit the following
Microsoft Accessibility Web site for additional
information that relates to keyboard shortcuts and
keyboard navigation in Windows and other Microsoft
products: http://www.microsoft.com/enable �

What an eventful computer summer we had. Lots of
interesting, good and, yes, terrible things happened. I
wonder what is yet to come in the weeks we have left before
the colors of Fall become its own natural event that throws
all things of summer into ancient history. Well, while
summer is still here and memory still serves us, this was the
time of the iPhone. It arrived with great fanfare, the
reviews, however, were underwhelming. Still, Apple, Inc.
sold its millionth iPhone less than three months after the
device’s debut. ITunes came front and center this summer,
killing off much of the CD business; there were writings
about the death throes of the DVD.

PC Magazine ran an article shrugging off the
Blu-Ray–HD DVD format wars with “Who cares.” The
author concludes that most people will never buy high
definition movies on disc. Broadband and download are the
way to go, movies on discs are being moved off center
stage. There are movies on demand, there are loads of free
movies on demand, Netflix is just one service that is now
offering movie downloads. Watching an HD movie will
soon involve “nothing more that point and click.”

One of the highlights of the summer was the Harry
Potter event. I don’t mean the amazing literary blockbuster
that was unleashed on the world at the end of July. I mean
the photograph of every single page of the 7th and final
installment of the Potter book that was circulated on the
Web before the official publication date. The millions of
fans of the book were already angry over the appearances
of reviews of the book before the magic hour of publication. 

Apparently, anything can be had on the Net. There are
all sorts of hard/software available for you to do your
spying, stealing or whatever you want to call it, and get it
on the Net. This summer there were reviews on pen
scanners, nifty little bitty things that you can use to scan a
book, private papers, whatever, and what you get is fully
editable typed text. A USB cable is all you need to get it to
work with your computer. These pen scanners are available
now. The price is lite. They are still in their early stages,
but improvements in quality are bound to come.

The Net has become intricately involved in computer
use. This past summer has made it abundantly clear:
computers and the Net are making for radical changes in
the way we live. Latest reports note, however, that we are a
long way off from living in a digital home where we can
connect all our electronic/PC devices and controlling all our
media through a single remote control. Still, changes are
coming, some are already here. Your dream house is no
longer the permanent fixture found only at the World’s
Fair, it’s just a couple of blocks away. �

  Did You Know . . .
— Donna Gorrell   

 Byting Remarks
— Jerry Finkelstein   

http://support.microsoft.com/kd/301583
http://[http://support.microsoft.com/kb/126449/
http://[http://support.microsoft.com/kb/255090/
http://www.microsoft.com/enable
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